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บทคัดย่อ 

ปริญญานิพนธ์ฉบับนี้จัดทำขึ้นเพื่อศึกษาการจ่ายแรงดัน โดยอิงจากสภาพแวดล้อมโดยรอบของ

แผงโซล่าเซลล์ โดยจะทำการเก็บข้อมูลค่าพารามิเตอร์ต่างๆ เช่น แรงดัน , กระแส , อุณหภูมิ , ความช้ืน 

และความเข้มแสงแล้วจะนำข้อมูลที ่ได้มาเก็บไว ้แล้วแสดงผลกราฟ โดยจะนำ Microcontroller 

ESP8266 มาเป็นตัวรับค่า ประมวลผล และส่งข้อมูลไปเก็บไว้ท่ี ThingSpeak ซึ่งการทำงานก็จะแบ่งเป็น 

2 ส่วน คือ ส่วนของ Hardware จะเป็นส่วนของ Module sensor ที่ใช้ทำการวัดค่าพารามิเตอร์ ซึ่ง

ประกอบด้วย ACS712 , Voltage sensor , DHT22 และ BH1750FVI จากนั้นจะนำค่าส่งไปยัง ESP8266 

เพื่อที่ส่งข้อมูลไปเก็บ โดยส่วนของ Software จะเป็นการเขียนแปรแกรมคำสั่งการทำงานในโปรแกรม 

Arduino IDE และเขียนโปรแกรมในส่วนของเว็บไซต์แล้วนำมาจากคลาวน์แล้วนำค่าที่ได้ไปแสดงผลเป็น

กราฟผ่านเว็บไซต์ Thingspeak และหน้าจอ LCD 
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ABSTRACT 

This project is designed to study pressure distribution. Based on the surrounding 

environment of the solar panel. It will collect data on various parameters such as voltage, 

current, temperature, humidity and light intensity and then store the obtained data and 

display a graph. The Microcontroller ESP8266 will be used to receive the values, process 

and send the data. Stored at Thingspeak, the work is divided into 2 parts : The Hardware 

part is the Module sensor that is used to measure parameters. Which consists of ACS712 

, Voltage sensor , DHT22 and BH1750FVI. Then the values will be sent to the ESP8266 for 

data to be sent and stored. The software part will be writing the work command program 

in the Arduino IDE program and writing the website program. It is then taken from the 

cloud and the obtained values are displayed as graphs on the Thingspeak website and 

LCD screen. 
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บทที่ 1 

บทนำ 

1.1 ท่ีมาและความสำคัญ 

ปัจจุบันเราไม่สามารถปฏิเสธได้ว่า พลังงานเป็นสิ่งที่มีความจำเป็นต่อชีวิตประจำวันของเรามาก 

ทั้งในส่วนของภาครัฐและภาคเอกชน ต่างก็ได้มีการรณรงค์ให้มีการประหยัดพลังงาน ซึ่งทางเลือกหนึ่งท่ี

นิยมใช้ก็คือ พลังงานแสงอาทิตย์ เนื่องจากเป็นพลังงานทดแทนที่เราสามารถหาได้ง่าย และเป็นพลังงาน

จากธรรมชาติที ่ไม่มีวันหมด และในปัจจุบันตามบ้านเรือนต่างๆ ก็มีความนิยมในการติดตั้งแผงเซลล์

แสงอาทิตย์ (Solar Module) เพื่อช่วยในการลดค่าใช้จ่ายไฟฟ้ามากยิ่งขึ้น แต่พลังงานไฟฟ้าที่ผลิตไดแ้ต่

ละวันนั้นมีการเปล่ียนแปลงอยูต่ลอดเวลา ขึ้นอยู่กับปัจจัยภายนอกต่างๆ เช่น ปริมาณความส่องสว่างของ

แสงแดด อุณหภูมิโดยรอบ ชนิดและขนาดของแผงเซลล์แสงอาทิตย์ เป็นต้น จึงจำเป็นที่จะต้องมีการจด

บันทึกข้อมูล เพื่อดูผลที่ได้รวมถึงแนวโน้มการเพิ่มขึ้น - ลดลงของพลังงานที่ได้จากแผงเซลล์แสงอาทติย์ 

ซึ่งโครงงานนี้ก็เป็นส่วนหนึ่งท่ีจะช่วยให้การจดบันทึกค่าท่ีทำการตรวจวัดนั้นมีประสิทธิภาพมากขึ้น และ

สามารถนำไปวิเคราะห์ผลต่อไปได้จึงได้ทำการศึกษาและจัดทำเครื่องมือวัดและบันทึกค่าเพื่อวิเคราะห์ 

ประสิทธิภาพของโซล่าเซลล์ โดยการใช้ไมโครคอนโทรลเลอร์ในการแก้ไขปัญหาความผิดพลาด และลด

เวลาการทำงานในการจดบันทึกของผู้ใช้งาน โดยเราจะบันทึกค่าอุณหภูมิโดยรอบบริเวณ Solar Module

บันทึกค่าความสว่างบริเวณ Solar Module และแสดงผลผ่านสัญญาณอินเตอร์เน็ตไร้สาย  

 

1.2 วัตถุประสงค์ 

1.2.1 เพื่อศึกษาเกี่ยวกับไมโครคอนโทรลเลอร์ 

1.2.2 เพื่ออํานวยความสะดวกในการจดบันทึกข้อมูล 

1.2.3 เพื่อให้ง่ายต่อการนําข้อมูลมาใช้ให้เกิดประโยชน์ 

 

1.3 ขอบเขตในการจัดทำ 

1.3.1 เก็บบันทึกค่าพลังงานท่ีได้จากแผงเซลล์แสงอาทิตย์แล้วนำไปแสดงผลผ่านทางเว็บไซต์

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหาและต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้
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1.4 ประโยชน์ท่ีคาดว่าจะได้รับ 

1.4.1 สามารถทราบได้ว่าแต่ละช่วงเวลานั้นมีพลังงานท่ีได้รับจากแผงเซลล์แสงอาทิตย์มากน้อย

อย่างไร 

1.4.2 ทำให้สามารถวัดค่าพลังงานท่ีได้จากแผงเซลล์แสงอาทิตย์ง่ายข้ึน 

1.4.3 สามารถดูข้อมูลค่าพารามิเตอร์ต่างๆของแผงเซลล์แสงอาทิตย์ได้ โดยไม่จำเป็นต้องไปวัด

ค่าท่ีอยากรู้ด้วยตนเอง 

1.5 ระยะเวลาในการดำเนินการ 

 1.5.1 ภาคเรียนท่ี 1 
รายละเอียด 

/สัปดาห์ท่ี 
สิงหาคม กันยายน ตุลาคม พฤศจิกายน 

1 2 3 4 1 2 3 4 1 2 3 4 1 2 3 

1. ปรึกษาอาจารย์ท่ีปรึกษา

เกี่ยวกับหัวข้อของโครงงาน 
               

2. ศึกษาหาข้อมูลท่ีเกี่ยวข้อง                

3. จัดซื้ออุปกรณ์                

4. ออกแบบโครงสร้างของตัว

อุปกรณ์ 

               

5. ทดสอบวงจร/อุปกรณ์                

6. ประกอบโครงสร้าง                

7. จัดทำรูปเล่มโครงงาน                

ตารางที่ 1.1 ระยะเวลาในการดำเนินโครงงานต้ังแต่วันท่ี 10 สิงหาคม 2566 ถึง 18 ตุลาคม 2566 

 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหาและต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้
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1.5.2 ภาคเรียนท่ี 2 
รายละเอียด 

/สัปดาห์ท่ี 
ธันวาคม มกราคม กุมภาพันธ์ มีนาคม 

1 2 3 4 1 2 3 4 1 2 3 4 1 2 3 

1. ปรึกษาอาจารย์ท่ีปรึกษา

เกี่ยวกับหัวข้อของโครงงาน 
               

2. ศึกษาหาข้อมูลท่ีเกี่ยวข้อง                

3. จัดซื้ออุปกรณ์                

4. ทดสอบวงจร/อุปกรณ์                

5. ทำการลอกลายบน PCB                

6. ประกอบโครงสร้าง                

7. จัดทำรูปเล่มโครงงาน                

ตารางที่ 1.2 ระยะเวลาในการดำเนินโครงงานต้ังแต่วันท่ี 14 ธันวาคม 2566 ถึง 6 มีนาคม 2567 

 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหาและต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้



บทที่ 2 

หลักการและทฤษฎี 

2.1 Solar Cell 

โซล่าเซลล์ (Solar Cell) หรือ เซลล์แสงอาทิตย์ และท่ีหลายๆ คนรู้จักในช่ือ เซลล์โฟโตโวลตาอิก 

(Photovoltaic cell) เป็นอุปกรณ์อ ิเล ็กทรอนิกส์ ม ีถ ูกนำมาใช้ก ันอย่างแพร่หลาย ในการผลิต

กระแสไฟฟ้าจากพลังงานแสงอาทิตย์ ท่ีทำจากสารกึ่งตัวนำชนิดพิเศษ ท่ีมีคุณสมบัติในการเปล่ียนพลังงาน

แสงอาทิตย์ ให้เป็นพลังงานไฟฟ้า (Solar Cell) โดยพลังงานกระแสไฟฟ้าท่ีผลิตได้จากโซล่าเซลล์นั้น เป็น

ไฟฟ้ากระแสตรง หรือ DC ท่ีสามารถนำมาใช้ประโยชน์ได้ทันที 

 

รูปที่ 2.1 Solar cell 

 

รูปที่ 2.2 คุณสมบัติของแผง Solar cell

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหาและต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้
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หลักการทำงานของ Solar Cell 

การทำงานของโซล่าเซลล์จะเป็นกระบวนการเปล่ียนจากพลังงานแสงให้กลายเป็นพลังงานไฟฟ้า

ได้โดยตรง โดยการใช้แสงซึ่งเป็นคลื่นแม่เหล็กไฟฟ้า และ มีพลังงานไปกระทบกับสารกึ่งตัวนำ จะทำให้

เกิดการถ่ายทอดพลังงานระหว่างกัน โดยพลังงานจากแสงจะทำให้เกิดอิเล็กตรอน หรือ การเคล่ือนท่ีของ

กระแสไฟฟ้าขึ้นในสารกึ่งตัวนำ จึงทำให้เกิดกระแสไฟฟ้าดังกล่าวที่สามารถนำไปใช้งานได้ 

แผงโซล่าเซลล์สามารถแบ่งออกได้เป็น 3 ชนิด ซึ่งแต่ละชนิดมีความแตกต่าง ข้อดีและเสียแตกต่างกันไป 

1. แผงโซล่าเซลล์ชนิด โมโนคริสตัลไลน์ (Monocrystalline Silicon Solar Cells) 

แผงโซล่าเซลล์ ชนิดที่ทำมาจาก ผลึกซิลิคอนเชิงเดี่ยว (mono-Si) หรือบางทีก็เรียกว่า single 

crystalline (single-Si) สังเกตุค่อนข้างง่ายกว่าชนิดอื่น เพราะจะเห็นแต่ละเซลล์ลักษณะเป็นส่ีเหล่ียมตัด

มุมท้ังส่ีมุม และมีสีเข้ม 

แผงโซล่าเซลล์ ชนิดที่ทำมาจาก ผลึกซิลิคอนเชิงเดี่ยว (mono-Si) หรือบางทีก็เรียกว่า single 

crystalline (single-Si) สังเกตุค่อนข้างง่ายกว่าชนิดอื่น เพราะจะเห็นแต่ละเซลล์ลักษณะเป็นส่ีเหล่ียมตัด

มุมท้ังส่ีมุม และมีสีเข้ม 

แผงโซล่าเซลล์ชนิด โมโนคริสตัลไลน์ นั้น เป็นชนิดท่ีทำมาจากซิลิคอนท่ีมีความบริสุทธิ์สูง โดยเริ่ม

มาจากแท่งซิลิคอนทรงกระบอก อันเนื่องมาจาก เกิดจากกระบวนการ กวนให้ผลึกเกาะกันท่ีแกนกลาง ท่ี  

เรียกว่า Czochralski process จึงทำให้เกิดแท่งทรงกระบอก จากนั้นจึงนำมาตัดให้เป็นส่ีเหล่ียม และลบ

มุมท้ังส่ีออก เพื่อท่ีจะทำให้ได้ประสิทธิภาพสูงสุด และลดการใช้วัตถุดิบโมโนซิลิคอนลง ก่อนท่ีจะนำมาตัด

เป็นแผ่นอีกที จึงทำให้เซลล์แต่ละเซลล์หน้าตาเป็นอย่างท่ีเห็นในแผงโซล่าเซลล์ 

ข้อดี 

o แผงโซล่าเซลล์ชนิด โมโนคริสตัลไลน์ มีประสิทธิภาพสูงสุด เพราะผลิตมาจาก ซิลิคอนเกรดดีท่ีสุด 

โดยมีประสิทธิภาพเฉล่ียอยู่ท่ี 15-20% 

o แผงโซล่าเซลล์ชนิด โมโนคริสตัลไลน์ มีประสิทธิภาพต่อพื้นท่ีสูงสุด เพราะว่าให้กำลังสูงจึง

ต้องการพื้นท่ีน้อยท่ีสุดในการติดต้ังแผงโซลล่าเซลล์ชนิดนี้ โมโนคริสตัลไลน์ สามารถผลิต

กระแสไฟฟ้าได้เกือบ 4 เท่า ของชนิด ฟิล์มบางหรือ thin film 

o แผงโซล่าเซลล์ชนิด โมโนคริสตัลไลน์ มีอายุการใช้งานยาวนานท่ีสุด โดยเฉล่ียแล้วประมาณ 25 ปี

ขึ้นไป 

o แผงโซล่าเซลล์ชนิด โมโนคริสตัลไลน์ ผลิตกระแสไฟฟ้าได้มากว่าชนิด โพลีคริสตัลไลน์ เมื่ออยู่ใน

ภาวะแสงน้อย 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหาและต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้
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ข้อเสีย 

o แผงโซล่าเซลล์ชนิด โมโนคริสตัลไลน์ เป็นชนิดท่ีมีราคาแพงท่ีสุด ในบางครั้งการติดต้ังด้วย แผงโซ

ล่าเซลล์ชนิด โพลีคริสตัลไลน์ หรือชนิด thin film อาจมีความคุ้มค่ามากกว่า 

o ถ้าหาก แผงโซล่าเซลล์ชนิด โมโนคริสตัลไลน์ มีความสกปรกหรือถูกบังแสงในบางส่วนของแผง 

อาจทำให้วงจรหรือ inverter ไหม้ได้ เพราะอาจจะทำให้เกิดโวลต์สูงเกินไป 

2. แผงโซล่าเซลล์ชนิด โพลีคริสตัลไลน์ (Polycrystalline Silicon Solar Cells) 

แผงโซล่าเซลล์ชนิด โพลีคริสตัลไลน์ เป็นแผงโซล่าเซลล์์ชนิดแรก ที่ทำมาจากผลึกซิลิคอน 

โดยท่ัวไปเรียกว่า โพลีคริสตัลไลน์ (polycrystalline,p-Si) แต่บางครั้งก็เรียกว่า มัลติ-คริสตัลไลน์ (multi-

crystalline,mc-Si) โดยในกระบวนการผลิต สามารถที่จะนำเอา ซิลิคอนเหลว มาเทใส่โมลด์ที่เป็นสี่หล่ี

ยมได้เลย ก่อนท่ีจะนำมาตัดเป็นแผ่นบางอีกที จึงทำให้เซลล์แต่ละเซลล์เป็นรูปส่ีเหล่ียมจัตุรัส ไม่มีการตัด

มุม สีของแผงจะออก น้ำเงิน ไม่เข้มมาก 

ข้อดี 

o แผงโซล่าเซลล์ชนิด โพลีคริสตัลไลน์ มีขั้นตอนกระบวนการผลิตที่ง่าย ไม่ซับซ้อน จึง ใช้ปริมาณ

ซิลิคอน ในการผลิตน้อยกว่า เมื่อเทียบกับ ชนิด โมโนคริสตัลไลน์ 

o แผงโซล่าเซลล์ชนิด โพลีคริสตัลไลน์ มีประสิทธิภาพในการใช้งาน ในท่ีอุณหภูมิสูง ดีกว่า ชนิด โม

โนคริสตัลไลน์ เล็กน้อย 

o แผงโซล่าเซลล์ชนิด โพลีคริสตัลไลน์ มีราคาถูกกว่าเมื่อเทียบกับ ชนิด โมโนคริสตัลไลน์ 

ข้อเสีย 

o แผงโซล่าเซลล์ชนิด โพลีคริสตัลไลน์ มีประสิทธิภาพโดยเฉล่ียอยู่ท่ี 13-16% ซึ่งต่ำกว่า เมื่อเทียบ

กับชนิด โมโนคริสตัลไลน์ 

o แผงโซล่าเซลล์ชนิด โพลีคริสตัลไลน์ มีประสิทธิภาพต่อพื้นท่ีต่ำกว่า ชนิด โมโนคริสตัลไลน์ 

o แผงโซล่าเซลล์ชนิด โพลีคริสตัลไลน์ มีสีน้ำเงิน ทำให้บางครั้งอาจดูไม่สวยงาม เมื่อเทียบกับ ชนิด 

โมโนคริสตัลไลน์ และชนิด thin film ท่ีมีสีเข้ม เข้ากับส่ิงแวดล้อม เช่น หลังคาบ้านได้ดีกว่า 

3. แผงโซล่าเซลล์ชนิด ฟิล์มบาง (Thin Film Solar Cells) แผงโซล่าเซลล์ อะมอร์ฟัส เป็นหนึ่งในหลาย

ชนิด ของแบบฟิล์มบาง 

หลักการโดยทั่วไปของการผลิต โซล่าเซลล์ ชนิดฟิล์มบาง (Thin Film Solar Cell, TFSC) คือ 

การนำเอาสารที่สามารถแปลงพลังงานจากแสงเป็นกระแสไฟฟ้า มาฉาบเป็นฟิล์มหรือชั้นบางๆ ซ้อนกัน

หลายๆช้ัน จึงเรียก โซล่าเซลล์ชนิดนี้ว่า ฟิล์มบาง หรือ thin film ซึ่งสารฉาบท่ีว่านี้ก็มีด้วยกันหลายชนิด 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหาและต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้
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ชื่อเรียกของ แผงโซล่าเซลล์ ชนิดฟิล์มบางจึงแตกต่างกันออกไป ขึ้นอยู่กับชนิดวัสดุที่นำมาใช้ ได้แก่ 

อ ะ ม อ ร ์ ฟ ั ส  Amorphous silicon (a-Si),Cadmium telluride (CdTe),Copper indium gallium 

selenide (CIS/CIGS) และ Organic photovoltaic cells (OPC) 

ด้านประสิทธิภาพของ แผงโซล่าเซลล์ ชนิดฟิล์มบางนั้น มีประสิทธิภาพเฉลี่ยอยู่ที่ 7-13% ทั้งนี้

ขึ้นอยู่กับชนิดของวัสดุที่นำมาทำเป็นฟิล์มฉาบ แต่สำหรับบ้านเรือนโดยทั่วไปแล้ว มีเพียงประมาณ 5% 

เท่านั้น ท่ีใช้ แผงโซล่าเซลล์ ท่ีเป็นแบบชนิดฟิล์มบาง 

ข้อดี 

o แผงโซล่าเซลล์ ชนิดฟิล์มบาง มีราคาถูกกว่า เพราะสามารถผลิตจำนวนมากได้ง่ายกว่า ชนิดผลึก

ซิลิคอน 

o ในท่ีอากาศร้อนมากๆ แผงโซล่าเซลล์ ชนิด ฟิล์มบาง มีผลกระทบน้อยกว่า 

o ไม่มีปัญหาเรื่อง เมื่อแผงสกปรกแล้วจะทำให้วงจรไหม้ 

o ถ้าคุณมีท่ีเหลือเฟือ แผงโซล่าเซลล์ ชนิด ฟิล์มบาง ก็เป็นทางเลือกท่ีดี 

ข้อเสีย 

o แผงโซล่าเซลล์ชนิดฟิล์มบาง มีประสิทธิภาพต่ำ 

o แผงโซล่าเซลล์ ชนิด ฟิล์มบาง มีประสิทธิภาพต่อพื้นท่ีต่ำ 

o ส้ินเปลืองค่าโครงสร้างและอุปกรณ์อื่นๆ เช่น สายไฟ 

o ไม่เหมาะนำมาใช้ตามหลังคาบ้าน เพราะมีพื้นท่ีจำกัด 

o การรับประกันส้ันกว่าชนิด ผลึกซิลิคอน 

 

2.2 NodeMCU ESP8266 

 

รูปที่ 2.3 NodeMCU ESP8266 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหาและต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้
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ESP8266 เป็นชื่อของชิปไอซีบนบอร์ดของโมดูล ซึ่งไอซี ESP8266 ไม่มีพื้นที่โปรแกรม (flash 

memory) ในตัว ทำให้ต้องใช้ไอซีภายนอก (external flash memory) ในการเก็บโปรแกรม ที่ใช้การ

เชื ่อมต่อผ่านโปรโตคอล SPI ซึ ่งสาเหตุนี ้เองทำให้โมดูล ESP8266 มีพื ้นที ่โปรแกรมมากกว่าไอซี

ไมโครคอนโทรลเลอร์เบอร์อื ่นๆ ESP8266 ทำงานที่แรงดันไฟฟ้า 3.3V - 3.6V การนำไปใช้งานร่วมกับ

เซ็นเซอร์อื่นๆท่ีใช้แรงดัน 5V ต้องใช้วงจรแบ่งแรงดันมาช่วย เพื่อไม่ให้โมดูลพังเสียหาย กระแสท่ีโมดูลใช้

งานสูงสุดคือ 200mA ความถ่ีคริสตอล 40MHz ทำให้เมื่อนำไปใช้งานอุปกรณ์ท่ีทำงานรวดเร็วตามความถี่ 

เช่น LCD ทำให้การแสดงผลข้อมูลรวดเร็วกว่าไมโครคอนโทรลเลอร์ยอดนิยม Arduino มาก 

ขาของโมดูล ESP8266 แบ่งได้ดังนี้ 

o VCC เป็นขาสำหรับจ่ายไปเข้าเพื่อให้โมดูลทำงานได้ ซึ่งแรงดันท่ีใช้งานได้คือ 3.3 - 3.6V 

o GND 

o Reset และ CH_PD (หรือ EN) เป็นขาท่ีต้องต่อเข้าไฟ + เพื่อให้โมดูลสามารถทำงานได้ ท้ัง 2 ขา

นี้สามารถนำมาใช้รีเซ็ตโมดูลได้เหมือนกัน แตกต่างตรงที่ขา Reset สามารถลอยไว้ได้ แต่ขา 

CH_PD (หรือ EN) จำเป็นต้องต่อเข้าไป + เท่านั้น เมื่อขานี้ไม่ต่อเข้าไฟ + โมดูลจะไม่ทำงานทันที 

o GPIO เป็นขาดิจิตอลอินพุต / เอาต์พุต ทำงานท่ีแรงดัน 3.3V 

o GPIO15 เป็นขาท่ีต้องต่อลง GND เท่านั้น เพื่อให้โมดูลทำงานได้ 

o GPIO0 เป็นขาทำหรับการเลือกโหมดทำงาน หากนำขานี้ลง GND จะเข้าโหมดโปรแกรม หาก

ลอยไว้ หรือนำเข้าไฟ + จะเข้าโหมดการทำงานปกติ 

o ADC เป็นขาอนาล็อกอินพุต รับแรงดันได้สูงสุดท่ี 1V ขนาด 10 บิต การนำไปใช้งานกับแรงดันท่ี

สูงกว่าต้องใช้วงจรแบ่งแรงดันเข้าช่วย 

 

2.3 DHT 22 

 
 

รูปที่ 2.4 DHT 22 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหาและต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้
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DHT 22 เป็นอุปกรณ์เซนเซอร์สำหรับวัดอุณหภูมิและความชื ้นสัมพัทธ์ (Temperature & 

Relative Humidity Sensor) การทดลองใช ้งานโมด ูล DHT22 ม ีราคาถ ูก ให ้ค ่าเป ็นแบบดิจ ิทัล 

ใช้ขาสัญญาณดิจิทัลเพียงเส้นเดียว โดยในการเชื่อมต่อแบบบิตอนุกรมสองทิศทาง (Serial Data, Bi-

Rirectional) โดยจะนำมาเช่ือมต่อกับ Arduino เพื่ออ่านค่าจากเซนเซอร์  
o ใช้แรงดันไฟเล้ียงได้ในช่วง 3.3 V ถึง 5.5 V  
o วัดอุณหภูมิได้ในช่วง -40 to 80 °C (±0.5 °C accuracy)  
o วัดความช้ืนสัมพัทธ์ได้ในช่วง 0 - 100 RH% (2 - 5% accuracy)  
o คอนเนคเตอร์แบบ 4 ขา  
o Pin 1 = VCC  
o Pin 2 = SDA (Serial data, bidirectional)  
o Pin 3 = ไม่ได้งาน 
o Pin 4 = GND 

หลักการทำงานของ DHT22 
ในการอ่านข้อมูลจากไอซีนั้น จะใช้ขาสัญญาณเพียงเส้นเดียวคือ DATA (หรือ SDA) 

แบบสองทิศทาง และ ในสถานะปกติสัญญาณ DATA จะเป็น HIGH ในการอ่านข้อมูลแต่ละครั้ง 

ไมโครคอนโทรลเลอร์จะต้องกำหนดให้ ขา DATA เป็นเอาต์พุต และสร้างบิต START ซึ่งจะต้องเป็น LOW 

อย่างน้อย 800 µsec จากนั้นจึงให้เป็น HIGH อย่างน้อย 20 µsec หลังจากนั้นจะเป็นการรอการตอบกลับ 

(Response) และจากไอซีขา DATA จะถูกต้อง เปล่ียนเป็นอินพุต เริ่มต้นของการตอบกลับไอซี 

จะดึงสัญญาณลงเป็น LOW และปล่อยให้เป็น HIGH ช่วงละ 80 µsec โดยประมาณ (เรียกว่า Response 

Bit) จากนั้นจึงจะเป็นการส่งข้อมูลทีละบิต รวม 40 บิต (ช่วง LOW ตามด้วยช่วง HIGH) ช่วง LOW 

ของแต่ละบิต จะกว้างเท่ากัน แต่จะต่างกันในช่วง HIGH สำหรับบิตท่ีมีค่าเป็น 0 หรือ 1 (ใช้ความกว้างช่วง 

HIGH ในการจำแนกค่าของบิต) 

 
รูปที่ 2.5 ลำดับของข้อมูลบิตในการอ่านค่าจากไอซีท้ังหมด 

 สองไบต์แรกสำหรับความช้ืน สองไบต์ต่อมาสำหรับอุณหภูมิและไบต์สุดท้ายเป็น Checksum หรือ 

Parity Bits 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหาและต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้
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รูปที่ 2.6 ลำดับของข้อมูลบิตในการอ่านค่าจากไอซีและความกว้างของช่วง LOW และ HIGH 

 

2.4 MCP3208 

 

รูปที่ 2.7 MCP3208 

เซ็นเซอร์ต่าง ๆ ท่ีต่อเข้ากับไมโครคอนโทรลเลอร์ มีการรับ - ส่งข้อมูลแบ่งเป็น 2 แบบใหญ่ ๆ คือ 

แบบดิจิตอล และแบบอนาล็อก แม้ในปัจจุบันเซ็นเซอร์ต่าง ๆ จะเปล่ียนการส่ือสารไปใช้แบบดิจิตอลแทบ

จะทั้งหมดแล้ว แต่ก็ยังมีเซ็นเซอร์บางชนิดที่ยังต้องสื่อสารแบบอนาล็อกอยู่ เช่น เซ็นเซอร์วัดความชื้นใน

ดิน เซ็นเซอร์วัดอุณหภูมิ TMP35 เซ็นเซอร์แสงใช้ LDR เซ็นเซอร์วัดกระแสไฟฟ้า เป็นต้น 

MCP3208 เป็นไอซี ADC ความละเอียด 12 บิต 8 ช่อง ตัวถังแบบ DIP-16 สามารถเสียบลงโพร

โทรบอร์ดได้ มีสเปคคร่าว ๆ ดังนี้ 

o รองรับแรงดันไฟเล้ียงได้ 2.7V ถึง 5.5V 

o ส่ือสารกับไมโครคอนโทรลเลอร์ผ่านบัส SPI 

o กำหนดค่าแรงดันอ้างอิงได้ 

o มีกราวด์แยกสำหรับวงจรฝ่ังอนาล็อก และดิจิตอล 

o มีโหมด Differential 

ขาต่อใช้งานมีท้ังหมด 16 ขา เสียบลงโพรโทรบอร์ด หรือแผ่นปริ้นอเนกประสงค์ได้พอดี ขาของไอซี

จะแยกเป็น 2 ฝ่ังชัดเจน คือฝ่ังด้านอินพุต เริ่มต้ังแต่ขา 1 ช่องท่ี 0 ไปจนถึงขา 8 ช่องท่ี 7 และฝ่ังด้าน

เอาต์พุต + จ่ายไฟเล้ียง 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหาและต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้
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รูปที่ 2.8 ขาของ MCP3208 

การเช่ือมต่อเป็นแบบ SPI เมื่อ 

o ขา CLK ให้ต่อเข้ากับ SCK หรือ CLK ของไมโครคอนโทรลเลอร์ 

o ขา DOUT ให้ต่อเข้ากับ MISO ของไมโครคอนโทรลเลอร์ 

o ขา DIN ให้ต่อเข้ากับ MOSI ของไมโครคอนโทรลเลอร์ 

o ขา CS ให้ต่อเข้ากับขา GPIO ใด ๆ ของไมโครคอนโทรลเลอร์ก็ได้ (ต้องกำหนดในโค้ดโปรแกรม

ว่าต่อขา CS ไว้ที่ขาอะไร) 

การใช้เซ็นเซอร์โดยท่ัวไปจะใช้แหล่งจ่ายไฟร่วมกับแหล่งจ่ายของไมโครคอนโทรลเลอร์ และใช้ร่วมกับ

ไอซี ADC ด้วย ดังนั้นช่อง AGND และ DGND สามารถต่อร่วมกัน แล้วต่อเข้าขา GND ปกติได้เลย 

ขา VDD และ Vref (ขาแรงดันอ้างอิง) มักต่อใช้ร่วมกัน ดังนั้นจึงจ่ายไฟเข้าขาท่ีต่อร่วมนี้ได้เลย 

 

2.5 ACS712 Current Sensor 

 
รูปที่ 2.9 ACS712 

ACS712 คือเซนเซอร์ที ่อาศัยหลักการวัดการเปลี่ยนแปลงของสนามแม่เหล็ก Hall effect 

สามารถวัดได้ท้ังกระแสตรง DC และกระแสสลับ AC ให้เอาต์พุตออกมาเป็นโวลต์สัมพันธ์กับกระแสท่ีวัด

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหาและต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้
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ได้ มีฟังก์ชั ่นป้องกันสัญญาณรบกวน , ตอนสนองต่อการวัดได้รวดเร็ว , เอาต์พุตมีความแม่นยำ

คลาดเคล่ือนประมาณ 1.5% สามารถเขียนโปรแกรมเพื่ออ่านค่าได้ง่าย   

การทำงานของเซนเซอร์ ACS712 Current Sensor เซนเซอร์ ACS712 ประกอบด้วยวงจร Hall 

Effect เอาต์พุตแบบเชิงเส้น มีวงจรเหนี่ยวนำไฟฟ้าทองแดงต้ังอยู่รอบ ๆ พื้นผิวของตัวชิฟ ACS712 เมื่อ

กระแส AC หรือ DC ผ่านเส้นทองแดงจะเกิดการสร้างสนามแม่เหล็ก สนามแม่เหล็กไฟฟ้านี้ทำปฏิกิริยากับ

เซนเซอร์ Hall Effect แปลงแม่เหล็กไฟฟ้านี้ เป็นแรงดันตามสัดส่วนของกระแสไฟฟ้าได้ท้ัง AC หรือ DC 

ขึ้นอยู่กับชนิดของกระแสไฟฟ้าอินพุต เราสามารถใช้บอร์ด Arduino หรือไมโครคอนโทรเลอร์รุ่นอื่น ๆ วัด

ค่าแรงดันนี้ได้โดยตรงเพื่อแปลงค่ากลับมาเป็นกระแสไฟฟ้า 

รูปขาของ ACS712 Pin Diagram ACS712 Hall Effect เซนเซอร์วัดกระแส 

 
รูปที่ 2.10 ขาของ ACS712 

ขาของ ACS712 เซนเซอร์วัดกระแส ดังรูปนี้  

o ขา 1,2 และ 3,4 ใช้สำหรับวัดกระแส เราสามารถเช่ือมต่อท่ีขานี้กับโหลดท่ีต้องการวัดได้ 

o ขา 6 กับ 5 ต่อ C สำหรับ filter ป้องกันสัญญาณรบกวน 

o ขา 5 ไฟกราวน์ 

o ขา 8 ไฟเล้ียง 5V  

o ขา 7 เป็นขาเอาต์พุตท่ีวัดได้ หน่วยเป็นโวลต์ 

 

2.6 Voltage Sensor Module 

Voltage Sensor Module โมดูลวัดแรงดันไฟฟ้า โวลต์เซ็นเซอร์ (DC 0-25V)  โมดูลนี้ขึ้นอยู่กับ

หลักการออกแบบของตัวแบ่งตัวต้านทานทำให้แรงดันไฟฟ้าขาเข้าของอินเทอร์เฟซเทอร์มินัลแคบลงห้า

เท่า แรงดันไฟฟ้าอินพุตแบบอนาล็อก Arduino สูงถึง 5V จากนั้นแรงดันไฟฟ้าอินพุตของโมดูลตรวจจับ

แรงดันไฟฟ้าต้องไม่เกิน 25V เนื่องจากชิป Arduino AVR ใช้ใน 10 AD ดังนั้นความละเอียดการจำลอง

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหาและต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้
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ของโมดูลนี้คือ 0.00489 V ดังนั้นโมดูลตรวจจับแรงดันไฟฟ้าอินพุตขั้นต่ำจึงตรวจจับแรงดันไฟฟ้า 

0.02445V  

 
รูปที่ 2.11 Voltage Sensor Module 

โมดูลเซ็นเซอร์แรงดันไฟฟ้าในขณะท่ีวัดคุณสมบัตินี้ 

o ช่วงแรงดันไฟฟ้าขาเข้า DC 0-25V 

o ช่วงการตรวจจับแรงดันไฟฟ้า DC 0.02445V-25V 

o ความละเอียดอนาล็อกแรงดันไฟฟ้า 0.00489V 

การต่อขาเซนเซอร์วัดแรงดันไฟ  Voltage Sensor Module วิธีการต่อใช้งาน 

o ขา - ต่อกับ กราวน์ 

o ขา + ต่อกับไฟ 5 หรือ 3.3 โวลต์ 

o ขา S ต่อกับขา A1 

o ขา Vcc ต่อกับไฟท่ีต้องการวัด 

ถ้าบอร์ด arduino ใช้ไฟเล้ียง 3.3V ไฟท่ีวัดได้สูงสุดคือ 16.5V  

ถ้าบอร์ด arduino ใช้ไฟเล้ียง 5V ไฟท่ีวัดได้สูงสุดคือ 24.9V 

 

2.7 BH1750FVI 

 

รูปที่ 2.12 BH1750FVI 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหาและต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้
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BH1750FVI เป็น IC เซนเซอรต์รวจจบัแสงโดยรอบแบบดจิติอลสืÉอสารแบบ I2C เซนเซอร์

นีÊเหมาะสาํหรบัการใชว้ดัค่าแสงแวดลอ้ม ขอ้มลูสาํหรบัปรบัไฟหน้าจอ LCD แบบอตัโนมตัติาม

ความเขม้ของแสงแวดล้อม  เป็นเซนเซอร์วัดความเข้มแสง (Light Intensity) มีหน่วยการวัดเป็น "ลักซ์" 

(Lux หรือ Lumen / m^2) สามารถวัดแสงท่ีสามารถมองเห็นได้ (Visible Light) และตอบสนองได้ดี

สำหรับแสงในช่วงประมาณ 500 ถึง 600 นาโนเมตรไอซีส่ือสารข้อมูลได้ด้วยบัส I2C (ความเร็วได้

ถึง 400kHz) ให้ข้อมูลจากการวัดแสงท่ีมีความละเอียด 16 บิต  

มคีุณสมบตัดิงันีÊ 

o ใช้แรงดันไฟเล้ียงได้ในช่วง 3 V ถึง 5 V  
o ตรวจจบัความสว่างไดท้ีÉ ř ถงึ Şŝ,535 lux 

o กนิกระแสไฟนอ้ยลง Ř.řŚ mA 

o ความแม่นยํา +/- 20% 

o เชืÉอมต่อเขา้กบัไมโครคอนโทรลเลอรผ์่าน I2C 

 

รูปที่ 2.13 BH1750 Block Diagram 

ภายในไอซี BH1750 ประกอบด้วยส่วนต่าง ๆ เริ่มต้นด้วย PD (Photo Diode) สำหรับรับแสง 

เมื่อได้รับแสงก็จะมีกระแสไฟฟ้าไหล มีการแปลงกระแสให้เป็นแรงดันไฟฟ้าโดยใช้วงจร Opamp-based 

Integrator แล้วแปลงให้เป็นข้อมูลดิจิทัล โดยใช้วงจร ADC (Analog-to-Digital Converter) และมี

หน่วยประมวลผลแบบดิจิทัลสำหรับเช่ือมต่อส่ือสารข้อมูลด้วยบัส I2C ไอซีมีขา ADDR หนึ่งขาสำหรับ

กำหนดแอดเดรสของอุปกรณ์ (0x23: ADDR=0 / floating และ 0x5C: ADDR=1 ต่อกับ +3.3V) 

 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 
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ในการวัดค่าแสง แบ่งออกได้เป็นสองรูปแบบการทำงาน คือ 

o One-Time Measurement เป็นการวัดค่าแสงเพียงหนึ่งครั้งแล้วไอซีจะเข้าสู่โหมดประหยัด

พลังงาน (Powerdown) โดยอัตโนมัติ 

o Continuous Measurement เป็นการวัดค่าแสงต่อเนื่องซ้ำไปเรื่อย ๆ 

2.8 LCD 

 

รูปที่ 2.14 LCD I2C 

LCD ย่อมาจากคำว่า Liquid Crystal Display ซึง่เป็นจอท่ีทำมาจากผลึกคริสตอลเหลว 

หลักการคือด้านหลังจอจะมีไฟส่องสว่าง หรือท่ีเรียกว่า Backlight อยู่ เมื่อมีการปล่อยกระแสไฟฟ้าเข้าไป

กระตุ้นท่ีผลึก ก็จะทำให้ผลึกโปร่งแสง ทำให้แสงท่ีมาจากไฟ Backlight แสดงขึ้นมาบนหน้าจอ ส่วนอื่นท่ี

โดนผลึกปิดกั้นไว้ จะมีสีท่ีแตกต่างกันตามสีของผลึกคริสตอล เช่น สีเขียว หรือ สีฟ้า ทำให้เมื่อมองไปท่ีจอ

ก็จะพบกับตัวหนังสือสีขาว แล้วพบกับพื้นหลังสีต่างๆกัน 

จอ LCD จะแบ่งเป็น 2 แบบใหญ่ๆตามลักษณะการแสดงผลดังนี้ 

1. Character LCD เป็นจอท่ีแสดงผลเป็นตัวอักษรตามช่องแบบตายตัว เช่น จอ LCD ขนาด 16x2 

หมายถึงใน 1 แถว มีตัวอักษรใส่ได้ 16 ตัว และมีท้ังหมด 2 บรรทัดให้ใช้งาน ส่วน 20x4 จะ

หมายถึงใน 1 แถว มีตัวอักษรใส่ได้ 20 ตัว และมีท้ังหมด 2 บรรทัด 

2. Graphic LCD เป็นจอท่ีสามารถกำหนดได้ว่าจะให้แต่ละจุดบนหน้าจอกั้นแสง หรือปล่อยแสง

ออกไป ทำให้จอนี้สามารถสร้างรูปข้ึนมาบนหน้าจอได้ การระบุขนาดจะระบุในลักษณะของ

จำนวนจุด (Pixels) ในแต่ละแนว เช่น 128x64 หมายถึงจอท่ีมีจำนวนจุดตามแนวนอน 128 จุด 

และมีจุดตามแนวตั้ง 64 จุด 

 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหาและต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้



16 
 

 
 

การเช่ือมต่อกับจอ Character LCD การเช่ือมต่อจะมีด้วยกัน 2 แบบ คือ 

o การเช่ือมต่อแบบขนาน - เป็นการเช่ือมต่อจอ LCD เข้ากับบอร์ด Arduino โดยตรง โดยจะ

แบ่งเป็นการเช่ือมต่อแบบ 4 บิต และการเช่ือมต่อแบบ 8 บิต ใน Arduino จะนิยมเช่ือมต่อแบบ 

4 บิต เนื่องจากใช้สายในการเช่ือมต่อน้อยกว่า 

o การเช่ือมต่อแบบอนุกรม - เป็นการเช่ือต่อกับจอ LCD ผ่านโมดูลแปลงรูปแบบการเช่ือมต่อกับจอ 

LCD จากแบบขนาน มาเป็นการเช่ือมต่อแบบอื่นท่ีใช้สายน้อยกว่า เช่น การใช้โมดูล I2C Serial 

Interface จะเป็นการนำโมดูลเช่ือมเข้ากับตัวจอ LCD แล้วใช้บอร์ด Arduino เช่ือมต่อกับบอร์ด

โมดูลผ่านโปรโตคอล I2C ทำให้ใช่สายเพียง 4 เส้น ก็ทำให้หน้าจอแสดงผลข้อความต่างๆออกมา

ได้ 

 
รูปที่ 2.15 ขาของ LCD I2C 

การควบคุมการแสดงผลของจอ LCD (I2C) 

ในการควบคุมหรือส่ังงาน โดยท่ัวไปจอ LCD จะมีส่วนควบคุม (Controller) อยู่ในตัวแล้ว ผู้ใช้

สามารถส่งรหัสคำส่ังสำหรับควบคุมการทำงานของจอ LCD (I2C) เช่นเดียวกันกับจอ LCD แบบ

ธรรมดา พูดง่ายๆ คือรหัสคำส่ังท่ีใช้ในการควบคุมนั้นเหมือนกัน แต่ต่างกันตรงท่ีรูปแบบในการรับส่ง

ข้อมูล จอ LCD จะมีการส่งข้อมูลรูปแบบ I2C ท่ีใช้ขาเพียง 4 ขาท่ีใช้ในการเช่ือมต่อเท่านั้น  

o GND เป็น Ground ใช้ต่อระหว่าง Ground ของระบบ Microcontroller กับ LCD  

o VCC เป็นไฟเล้ียงวงจรท่ีป้อนให้กับ LCD มีขนาด +5VDC 

o SDA (Serial Data) เป็นขาท่ีใช้ในการรับส่งข้อมูล 

o SCL (Serial Clock) เป็นขาสัญญาณนาฬิกาในการรับส่งข้อมูล 
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การรับ-ส่งข้อมูลแบบ I2C BUS 

 

รูปที่ 2.16 การรับ-ส่งข้อมูลแบบ I2C 

MCU จะทำการส่งสถานะเริ่มต้น (START Conditions) เพื่อแสดงการขอใช้บัส แล้วตามด้วย 

รหัสควบคุม (Control Byte) ซึ่งประกอบ ด้วยรหัส ประจำตัวอุปกรณ์ Device ID, Device Address และ 

Mode ในการเขียนหรืออ่านข้อมูล เมื่ออุปกรณ์รับทราบว่า MCU ต้องการจะติดต่อด้วย ก็ต้องส่งสถานะ

รับรู้ (Acknowledge) หรือแจ้งให้ MCU รับรู้ว่าข้อมูลท่ีได้ส่งมามีความถูกต้อง และเมื่อส้ินสุดการส่งข้อมูล 

MCU จะต้องส่งสถานะส้ินสุด (STOP Conditions) เพื่อบอกกับอุปกรณ์ว่า ส้ินสุดการใช้บัส 

2.9 ตัวต้านทานไวร์วาวด์หุ้มฮิทซิงค์ ( Aluminium Housed Resistor ) 

 

รูปที่ 2.17 ตัวต้านทานไวร์วาวด์ 

ตัวต้านทานหุ้มฮิทซิงค์เป็นตัวต้านทานไวร์วาวด์ชนิดหนึ่งเรียกช่ือตามวัสดุท่ีใช้หุ้มคือฮิทซิงค์   ฮิท

ซิงค์ช่วยให้ตัวต้านทานระบายความร้อนได้ดีขึ้นมาก ทำให้วัตต์ตัวต้านทานเพิ่มขึ้นประมาณ 40-50%  เช่น 

ตัวต้านทานหุ้มฮิทซิงค์ 10W  ถ้าไม่หุ ้มฮิทซิงวัตต์จะลดเหลือเพียง  5.5W     ตัวต้านทานหุ้มฮิทซิงค์ 

50W  ถ้าไม่หุ้มฮิทซิงวัตต์จะลดเหลือเพียง  20W   เป็นต้น  การใช้งานมีใช้งานท่ัวไป และใช้งานในระบบ

ควบคุมอุตสาหกรรมสีของตัวต้านทานชนิดนี้ส่วนใหญ่เป็นสีทองและอาจมีสีเงินอยู่บ้าง ตัวต้านทานหุ้มฮิท

ซิงค์วัตต์ต่ำจะมีขาแบบบัดกรีถ้าวัตต์สูงจะมีขาแบบขันน๊อต  ที่ตัวต้านทานจะพิมพ์ค่าความต้านทาน ค่า
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ว ั ตต ์  และ   %  ความคลาด เคล ื ่ อน ไว ้ท ำ ให ้ ง ่ า ย ในการ เล ื อก ใช ้ ง านและหาร ุ ่ น ทดแทน  

 

คุณสมบัติของตัวต้านทานหุ้มฮิทซิงค์ 

- มีค่าให้เลือกใช้งานต้ังแต่ค่าโอมต่ำจนถึงค่า K ohm 

-  มีค่าวัตต์ให้เลือกใช้งาน  5W  -  300W 

-  ค่าสัมประสิทธิ์ความต้านทานต่ออุณหภูมิเสถียรดีมาก    <±1%   ±1%   ±3%   ±5%   ±10% 

ฮิทซิงค์และสารนำความร้อนท่ีอยู่ข้างในช่วยให้ตัวต้านทานระบายความร้อนได้อย่างรวดเร็ว 

-  ป้องกันตัวต้านทานจากแวดล้อมได้ดีมาก   โครงสร้างและช้ินส่วนท่ีเช่ือมและหุ้มปิดช่วยป้องกันฝุ่นและ

ความช้ืนไม่ให้เข้าไปข้างในได้   (กรณีป้องกันไม่ดีความช้ืนจะทำให้คุณสมบัติของวัสดุตัวต้านทานข้างใน

เส่ือมค่าและเปล่ียนค่า) 

-  ทนสัญญานพัลซ์ได้ดีเย่ียม 
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บทที่ 3 

หลักการทำงานและการออกแบบ 

3.1 วัสดุ อุปกรณ์ เครื่องมือหรือโปรแกรมท่ีใช้ 

o NodeMCU ESP8266 

o DHT 22 

o BH1750FVI 

o MCP3208 

o LCD I2C ขนาด 20*4 

o ตัวต้านทานไวร์วาวด์ 4Ω 100W 

o ACS712 Current Sensor 

o Voltage Sensor Module 

o Resistor 

o กล่องบรรจุอุปกรณ์  

o เว็บไซต์ Thingspeak 

o เว็บไซต์ Wordpress 

o โปรแกรม Arduino IDE 
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3.2 ข้ันตอนการดำเนินการ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

รูปที่ 3.1 แผนภาพ Flowchart ขั้นตอนการทำงาน 

 

 

 

เริ่มการทำงาน 

จัดทำเอกสารแบบร่าง 

แก้ไข 
ส่งให้ท่ีปรึกษา

ตรวจสอบ 

ศึกษาหลักการทำงานของตัวอุปกรณ์และเอกสารท่ีเกี่ยวข้อง 

NO 

YES 

ออกแบบการทำงาน 

สร้างอุปกรณ์ฮาร์ดแวร์และเขียนโปรแกรม 

ตรวจสอบความเรียบร้อย 

จัดทำรูปเล่มโครงการและจัดทำวิดีโอนำเสนอ 

ง 

จบการทำงาน 
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3.3 การออกแบบและจัดทำระบบ 

 การออกแบบวงจรนี้แบ่งออกเป็น 2 ส่วน คือ การออกแบบทางด้าน Hardware และการ

ออกแบบทางด้าน Software 

 3.3.1 การออกแบบทางด้าน Hardware  

 

รูปที่ 3.2 Schematics 

 

รูปที่ 3.3 การออกแบบแผ่น PCB 
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รูปที่ 3.4 แผ่น PCB ก่อนทำการกัดปริ้น 

3.3.2 การออกแบบทางด้าน Software 

3.3.2.1 Arduino IDE 

Arduino IDE เป็นชื่อเรียกของแพลตฟอร์มการเขียนโปรแกรมลง ไมโครคอนโทรลเลอร์ 

(Arduino) ท่ีเราสามารถสร้างสรรส่ิงต่าง ๆ จากการออกแบบได้ตามความคิด แล้วสร้างออกมาเป็นช้ินงาน

ท่ีใช้ได้จริง โดยไม่จำเป็นต้องมีความรู้เรื่องการต่อวงจรท่ีซับซ้อน การเขียนโปรแกรมทีเข้าใจง่ายด้วยภาษา 

C , C++ มีโค้ดตัวอย่างและโปรเจคให้ศึกษาจำนวนมาก บอร์ดทดลองราคาไม่แพง มีให้เลือกใช้งานตาม

ความเหมาะสม มีเซนเซอร์โมดูล และอุปกรณ์เสริมจำนวนมาก แพลตฟอร์มเป็นแบบโอเพ่นซอร์ส สามารถ

ใช้งานได้ฟรี ด้วยความง่ายครบถ้วนและฟรีนี้ จึงทำให้มีผู้ใช้งานท่ัวโลก และมีการพัฒนาให้ดีขึ้นอย่าง

ต่อเนื่อง 

แนวคิดการใช้งานโปรแกรม Arduino IDE 

1. เขียนโปรแกรมด้วยภาษา C/C++ สำหรับ Arduino 

2. คอมไพล์หรือแปลโปรแกรมภาษา C/C++ ให้เป็นภาษาสำหรับไมโครคอนโทรลเลอร์และบันทึก

เป็น Intel Hex File 

3. อัพโหลด Intel Hex File ลงบนไมโครคอนโทรลเลอร์ซึ่งอยู่บนบอร์ด Arduino ผ่านสาย USB 

หรือผ่าน Programmer 

วิธีใช้งานโปรแกรม Arduino IDE 
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1. เปิดโปรแกรม Arduino IDE ขึ้นมา 

 

รูปที่ 3.5 หน้าแรกของโปรแกรม Arduino IDE 

2. สร้าง Sketch ใหม่ โดยคลิกท่ีเมนู File > New 

รูปที่ 3.6 หน้าต่าง File ของโปรแกรม Arduino IDE 

3. เขียนโปรแกรมลงไปตรงพื้นท่ีสีขาวๆ ครับ ซึ่งการเขียนโปรแกรมสำหรับ Arduino จะประกอบไป

ด้วยฟังก์ช่ัน setup และ ฟังก์ช่ัน loop ซึ่งมีความหมายดังนี้ 

o ฟังก์ช่ัน setup จะเริ่มทำงานเป็นอันดับแรกเมื่อ Arduino เริ่มทำงาน และคำส่ังท่ีถูกเขียนลงไป

ในนี้ จะทำงานเพียงครั้งเดียวเท่านั้น 
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o ฟังก์ช่ัน loop จะเริ่มทำงานทันทีเมื่อฟังก์ช่ัน setup ทำงานเสร็จ และคำส่ังท่ีถูกเขียนลงไปในนี้ 

จะทำงานต้ังแต่คำส่ังแรก ไล่ไปจนถึงคำส่ังสุดท้าย แล้วกลับมาท่ีคำส่ังแรก ไล่ไปจนถึงคำส่ัง

สุดท้าย วนซ้ำแบบนี้ไปเรื่อยๆ ตลอดการทำงานของ Arduino 

 

รูปที่ 3.7 ส่วนท่ีทำการเขียนโปรแกรม 

4. ในการ Programming บางครั้งเราอาจจะต้องเพิ่ม Library ให้กับตัวโปรแกรมเพื่อท่ีจะสามารถ

เรียกใช้โค้ดเฉพาะของอุปกรณ์ตัวต่างๆ ได้ ซึ่งบางอันสามารถหาโหลดได้จากโปรแกรม Arduino IDE ได้

เลย โดยไปท่ีเมนู Tools > Manage Libraries แต่บางอันท่ีไม่มีก็จะต้องหาโหลดจากเว็บไซต์ต่างๆ เช่น 

GitHub เป็นต้น 

 
รูปที่ 3.8 หน้าต่าง Tools ของโปรแกรม Arduino IDE 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหาและต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้



25 
 

 
 

 

รูปที่ 3.9 หน้าต่าง Library Manager 

หลังจากเราเจอ Library ท่ีเราต้องการใน GitHub ก็ทำการดาวน์โหลดโดยการกดท่ีเมนู Code > 

Download ZIP จากนั้นทำการแตกไฟล์และทำไปใส่ในโฟลเดอร์ Libraries ของ Arduino IDE 

 

รูปที่ 3.10 หน้าโหลด Libraries ของเว็บไซต์ GitHub                                                                               

5. หลังจากท่ีทำการลง Libraries และเขียนโค้ดเสร็จแล้ว ก็ทำการเลือก Board ท่ีเราจะทำการ

อัพโหลดโค้ดลงไปโดยไปท่ีเมนู Tools > Board โดยจะเป็น Board ท่ีเราได้ดาวน์โหลดเอาไว้  
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รูปที่ 3.11 เลือก Board โดยการไปท่ีเมนู Tools > Board 

6. การนั้นก็ทำการ Verify และอัพโหลดลง Arduino ก็เป็นการเสร็จส้ิน 

3.3.2.2 WordPress 

WordPress คือ เครื ่องมือสร้างเว็บไซต์ แบบ Zero code เราสามารถออกแบบเว็บ เพิ่มเติม

บทความ รูปภาพ ได้เองแบบง่ายๆ โดยไม่ต้องมีความรู้เรื่อง Code หรือความรู้ด้านโปรแกรมมิ่งเลย 

ทำไมถึงควรใช้ WordPress 

o ประหยัดค่าใช้จ่าย 

ใครๆ ก็สามารถโหลด WordPress มาใช้ได้ฟรี เพราะเป็น Opensource ดังนั้นเราจึงประหยัดค่าใช้จา่ย

ในการจ้างคนเขียนโปรแกรม เราสามารถเรียนรู้และทำด้วยตนเองได้เลย 

o ไม่ต้องเขียนโค้ดให้ยุ่งยาก 

การสร้างเว็บด้วย WordPress เราไม่จำเป็นต้องมีทักษะ coding แต่เขาจะมีช้ินส่วนต่างๆ เตรียมไว้ให้เรา 

เราสามารถนำช้ินส่วนเหล่านั้น มาลากและวาง ประกอบร่างเป็นเว็บได้อย่างท่ีใจต้องการเลย 

o มีฟังก์ชันต่างๆ มากมาย 

ทุกระบบ ทุกฟังก์ชันท่ีเราต้องการ จะมีผู้สร้างปล๊ักอิน WordPress จากท่ัวโลก ทำเตรียมไว้ให้ เราก็แค่ไป

ค้นหา และหยิบมาใส่บนเว็บ WordPress ของเราได้เลย เช่น ระบบ Ecommerce ระบบ Booking เป็น

ต้น 

o อัพเดทเนื้อหาต่างๆ ได้ง่าย 

เพราะ WordPress ใช้งานง่าย ใช้งานได้บนทุกอุปกรณ์ คุณสามารถเพิ่มข้อมูลหรืออัพเดทเนื้อหาได้ตลอด 

ทุกท่ี ทุกเวลา แก้จุดไหนผิด หรือเผลอลบข้อมูลแบบไม่ต้ังใจ ตัว WordPress ยังมีความสามารถ restore 

กู้เนื้อหาเดิมกลับคืนมาได้อีกด้วย 
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o มีธีมให้เลือกเยอะ ดีไซน์สวยงาม 

เราสามารถใช้ WordPress ออกแบบเว็บให้สวยๆ ได้ทุกจินตการ หรือหากคุณไม่มีไอเดียในการออกแบบ

เว็บ แต่ละธีมของ WordPress เขาจะมี Template การดีไซน์เว็บ ที่ออกแบบไว้อย่างสวยงาม มาให้เรา

เลือกใช้อีกด้วย 

o ทำ SEO ง่าย 

WordPress มีฟังชั่นสำหรับทำ SEO เตรียมไว้แบบครบวงจร และมีโครงสร้างเว็บที่เป็นมิตรกับการให้ 

Google เก็บข้อมูล ซึ่ง Google เองยังแนะนำให้คนทั่วไปที่ไม่เก่ง SEO ควรเลือกใช้ WordPress ในการ

สร้างเว็บ 

วิธีการใช้งาน WordPress 

1. เมื ่อ Login เข้ามาแล้ว ก็กดไปที่เมนู Pages ตรง Control panel ของ WordPress ก็จะ

สามารถเพิ่ม Pages หรือแก้ไข Pages ต่างๆ ได้ดังรูป 

 
รูปที่ 3.12 เมนู Pages 

2. หากเราต้องการแก้ไขหน้า Home ก็ทำการกด Edit using Pagelayer ก็จะสามารถเปลี่ยน

ได้หมดทุกอย่างไม่ว่าจะเป็นข้อความ รูปภาพ หรือพื้นหลัง  

 
รูปที่ 3.13 กด Edit using Pagelayer เพื่อทำการแก้ไข 
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รูปที่ 3.14 ตัวอย่างการแก้ไขหน้า Home 

3. และเมื่อทำ Pages ท่ีต้องการเสร็จหมดแล้วสามารถมาเลือก Pages ท่ีต้องการแสดงได้ท่ี 

Appearance > Menus เลือก Pages ท่ีต้องการ แล้วกด Add to Menu 

 

รูปที่ 3.15 หน้า Menus 

3.3.2.3 ThingSpeak  

ThingSpeak คือผู้ให้บริการ Cloud ชนิดหนึ่ง ท่ีอนุญาตให้เราสามารถส่งค่าต่างๆขึ้นเพื่อไปเก็บ

บนพื้นท่ี ท่ีเปิดให้เราใช้บริการ และยังเปิดให้เราสามารถเข้าถึงข้อมูลเหล่านี้ได้จากเวปบราวเซอร์ท่ัวๆไป

จากท่ีไหนก็ได้ท่ีมี Internet จึงนับเป็นการเข้าถึงข้อมูลในรูปแบบ IOT (Internet of Things) 

วิธีการใช้งาน ThingSpeak 

1. ต้องสมัครใช้งาน ThingSpeak โดยเข้าไปท่ี https://thingspeak.com/  แล้วกดที่ปุ ่ม “Get 

Started For Free” เพื่อสมัครใช้งาน 

2. หลังจากทำการสมัครเสร็จทำการเข้าสูระบบ 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 
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รูปที่ 3.16 หน้าเข้าสู่ระบบของเว็บไซต์ ThinkSpeak 

3. ทำการสร้าง Channel ใหม่ด้วยการกด New Channel 

 

รูปที่ 3.17 หน้าสร้าง My Channels 

4. ต้ังช่ือ Channel และเลือกกับต้ังช่ือ Field ท่ีเราต้องการใช้งาน โดยเราสามารถเลือกได้สูงสุด 8 

Fields  

 

รูปที่ 3.18 หน้าต้ังช่ือ Channel และ Field 

5. เมื่อสร้างเสร็จ เข้าไปในส่วนของ API Keys ซึ่งในแต่ละ Channel จะมี API key เฉพาะตัว ทำให้

เราสามารถส่งข้อมูลไปยัง Channel ของเราได้ถูกต้อง 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 
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รูปท่ี 3.19 หน้าดู API Keys ของ ThingSpeak 

6. สามารถปรับ Timescale ปรับสีต่างๆ ของกราฟและสามารถเพิ่ม Widget ต่างๆ ได้ผ่าน Add 

Widgets 

 

รูปที่ 3.20 หน้าต่างปรับ Timescale และสีของกราฟ 

 

รูปที่ 3.21 หน้าต่าง Add Widgets 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 
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3.4 ผังงาน (Flowchart) 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

รูปที ่3.22 ผังงานแสดงขั้นตอนการทำงาน 

 

 

ไม่สำเร็จ 

รับค่าจากเซ็นเซอร์ 

จบ 

เช่ือมต่อ WIFI 

สำเร็จ 

เช่ือมต่อ Thingspeak 

แสดงผลผ่านเว็บไซต์ Thingspeak 

และหน้าจอ LCD 

ส่งข้อมูลไปท่ี Thingspeak 

ผู้ใช้หยุดการทำงาน 

ผู้ใช้เริ่มการทำงาน 

เริ่ม 
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บทที่ 4 

ผลการทดลอง 

4.1 การแสดงผลด้าน Software 

4.1.1 วัดค่าพารามิเตอร์ต่างๆ โดยแสดงผลผ่านหน้าจอ Serial Monitor 
  เปิดโปรแกรม Arduino IDE ท่ีเขียนคำส่ังไว้ จากนั้นเรียกใช้ Serial Monitor โดยคลิกท่ี 

Tools > Serial Monitor หรือกดปุ่ม Ctrl + Shift + M 

   

รูปท่ี 4.1 หน้า Serial Monitor ในโปรแกรม Arduino IDE 

4.2 การแสดงผลจากเว็บไซต์ 

 4.1.2.1 อ่านค่าพารามิเตอร์ต่างๆ จาก Serial Monitor และดูค่าท่ีได้จากเว็บไซต์ 

Thingspeak  

รูปที่ 4.2 หน้าต่างแสดงผลค่า ณ ปัจจุบัน และกราฟแสดงค่าก่อนหน้า
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ไม่ว่ากรณีใดๆ ทั้งสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหาและต้องอ้างอิงถึงเจ้าของเอกสารทุกครั้งที่มีการนำไปใช้



33 
 

 
 

4.2.2 นอกจากนี้ยังสามารถ Export Data ใน Field ต่างๆ หรือท้ังหมดออกมาเป็นไฟล์ Excel 

ได้ 

 

รูปที่ 4.3 หน้าต่าง Export recent data 

 

รูปที่ 4.4 ตัวอย่าง Data ท่ีเก็บใน Excel 

4.2.3 เว็บไซต์ท่ีใช้ในการแสดงผลเกี่ยวกับประวัติความเป็นมา ท่ีมาและความสำคัญ และการ

แสดงข้อมูลต่างๆ ท่ีได้จากการทดลอง 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 
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รูปที่ 4.5 หน้าจอหลักของเว็บไซต์ Wordpress  

https://solardata.thaisolarengineer.com/ 

 
รูปที่ 4.6 ลองนำไปต่อกับ Power supply ก่อนใช้งานจริง 

รูปที่ 4.7 นำไปใช้งานจริง 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 
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บทที่ 5 

สรุปผลการทดลองและข้อเสนอแนะ 

  

5.1   สรุปผล 

ในปริญญานิพนธ์ฉบับนี้มีการศึกษาและออกแบบการใช้ Volt sensor module , Current 

sensor module , Digital Temperature and Humidity Sensor และ Light sensor ร่วมกับ Node 

mcu esp8266 เพื่อมาประยุกต์ใช้ในการวัดแรงดันไฟฟ้า , กระแสไฟฟ้า , อุณหภูมิ , ความชื้น และ 

ความเข้ม แสง เพื่อแสดงผลผ่านเว็บไซต์โดยการออกแบบจะแบ่งเป็น 2 ส่วน คือ ส่วนที่ 1 คือด้าน 

software เป็นการสร้างเว็บไซต์ Website และนำ data จาก data base มาแสดงบนเว็บไซต์ ส่วนที่ 2 

จ ะ เ ป ็ น ส ่ ว น ต ั ว บ อ ร ์ ด ข อ ง ว ง จ ร  ห ร ื อ  hardware โ ด ย เ ร า จ ะ น ำ ต ั ว บ อ ร ์ ด นี้  

ไ ปบร รจ ุ ใ นกล ่ อ ง แ ละน ำ ไปว า ง ใก ล ้ ๆก ั บ  Solar cell เพ ื ่ อ ทำก าร ว ั ด ค ่ า ต ่ า ง ๆ  โ ดย จ ะ

นำสายไฟปากคีบไปจับกับสายไฟ ของ Solar cell จากนั ้นแรงดันจาก solar cell จะผ่าน voltage 

divider ลดแรงดันเพื ่อเข้าไปใน Volt sensor module และค่าที ่ออกจาก module ที ่เป็น Analog 

จะไปเข้า mcp3208 ที่ต้องใช้ mcp3208 เพื่อเพิ่มจำนวนบิตเป็น 12 บิต และค่าที่ออกจาก mcp3208 

เป็น digital ไปเข้าขาที่เป็น digital ของ esp8266 ส่วน current วัดได้จากแรงดันไฟที่ออกจาก solar 

cell ไปต่อกับ Load ที่เป็น R Shunt และเอา current sensor module มาวัดโดยต่ออนุกรมกับ load 

จากนั ้นค่าที ่ออกมาจาก Current sensor module เป็น Analog ไปเข้าขา Analog ของ esp8266 

และค่าพารามิเตอร์ ความ เข้มแสง , อุณหภูมิ, ความชื ้น ที ่ออกมาจาก sensor เข้าขา digital ของ 

esp8266 จากนั ้นทำการเขียน โปรแกรมในส่วนของ software เพื ่อนำ data แรงดันไฟ กระแสไฟ 

กำลังไฟฟ้า อุณหภูมิ ความช้ืน ความเข้มแสง ไปเก็บใน excel และแสดงผลออกมาเป็นกราฟผ่านเว็บไซต์ 

Thingspeak 
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5.2 ข้อเสนอแนะ 

1. เพื่อให้การวัดมีความแม่นยำท่ีมากขึ้นควรจะใช้ โมดูลวัดแรงดันท่ีเป็น PZEM-017 ซึ่ง 

สามารถรับแรงดันได้ในช่วงท่ีมากขึ้นสามารถรองรับแรงดันจากโซล่าเซลล์ได้ โดยไม่ต้องผ่าน การ divider 

ท่ีอาจเกิดค่าความคลาดเคล่ือนได้ 

2. ในส่วนของ Website ควรจะดู/เช็คข้อมูลเป็นช่วงๆ เพราะข้อมูลที่เข้ามาจะเข้ามาทุกๆ 10 

นาที เพราะฉะนั้นการท่ีเข้ามาดูถี่ๆจะไม่ตอบสนองต่อจุดประสงค์ของการทดลอง 

 3. อาจจะต้องหาโหลดท่ีสามารถทนทานต่ออุณหภูมิและการใช้งานได้มากกว่านี้ 
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//----------------------------------------Include the NodeMCU ESP8266 Library 
#include <ESP8266WiFi.h> 
#include <Wire.h> //BH1750 
#include "BH1750FVI.h" //BH1750 
#include <MCP3208.h> 
#include <SPI.h> 
#include "LiquidCrystal_I2C.h" 
//---------------------------------------- 
#include "DHT.h"  //--> Include the DHT Sensor Library  
#define DHTTYPE DHT22 //--> Defines the type of DHT sensor used (DHT11, DHT21, and DHT22), 
in this project the sensor used is DHT11. 
 
String apiKey = "U87UIGXD5I9TUGAJ"; //--> Enter your Write API key from ThingSpeak 
 
//----------------------------------------SSID and Password of your WiFi router 
const char* ssid = "Parn"; 
const char* password = "ppakrinn"; 
//---------------------------------------- 
//----------------------------------------ThingSpeak Server 
const char* server = "api.thingspeak.com"; 
//---------------------------------------- 
 
const int DHTPin = 2; //--> The pin used for the DHT11 sensor is Pin D1=Pin 5 
DHT dht(DHTPin, DHTTYPE); //--> Initialize DHT sensor, DHT dht(Pin_used, 
Type_of_DHT_Sensor); 
BH1750FVI LightMeter(BH1750FVI::k_DevModeContLowRes); //BH1750FVI 
MCP3208 adc(D8); 
LiquidCrystal_I2C lcd(0x27, 20, 4); 
WiFiClient client; 
 
// Sensitivity for ACS712  
int Sens = 66;  // Sensitivity in mV/A for the 5A  
// int Sens = 100; // Sensitivity in mV/A for the 20A  
const int analogIn = A0;   // Analog input pin  
int OffsetVoltage = 2700;  // 0 Current offset Voltage in mV @ 0 amps  
int RawValue = 0;           
double Voltage = 0;         
double Current = 0;         
double Current2 = 0;    
double Power; 
void setup() { 
  // put your setup code here, to run once: 
  lcd.begin(); 
  Serial.begin(115200); 
  dht.begin();  //--> Start reading DHT22 sensors 
  delay(5000); 
   
  WiFi.begin(ssid, password); //--> Connect to your WiFi router 
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  Serial.println(""); 
   
   // Initialize the I2C bus (BH1750 library doesn't do this automatically) 
  Wire.begin(); //BH1750 
  // On esp8266 you can select SCL and SDA pins using Wire.begin(D4, D3); 
  // For Wemos / Lolin D1 Mini Pro and the Ambient Light shield use Wire.begin(D2, D1); 
 
  LightMeter.begin(); //BH1750   
   adc.begin(); 
   
  //----------------------------------------Wait for connection 
  Serial.print("Connecting"); 
  while (WiFi.status() != WL_CONNECTED) { 
    Serial.print("."); 
    delay(500); 
  } 
   
  //----------------------------------------If connection successful show IP address in serial monitor 
  Serial.println(""); 
  Serial.print("Successfully connected to : "); 
  Serial.println(ssid); 
} 
 
void loop() { 
  // put your main code here, to run repeatedly: 
  float h = dht.readHumidity(); //DHT22 Humidity 
  float t = dht.readTemperature(); //DHT22 Tempearature 
  int lux = LightMeter.GetLightIntensity(); //BH1750 
  double val = mapf(adc.analogRead(0), 0, 4095, 0, 25); 
  double volt = val*6; //ทาํค่ากลบัเป็น Input จากการ Divider ประมาณ 6.2 เท่า 
   //---------------------------find current--------------------------------------  
    RawValue = analogRead(analogIn);           // Read voltage from ASC712  
    Voltage = (RawValue / 1024.0) * 5000;      // Convert to mV  
    Current2 = (-(Voltage - OffsetVoltage) / Sens); // Convert to amps  
    Current = Current2/3;  
    Power = Current * volt; 
  delay(5000);     
  if (isnan(h) || isnan(t)) { 
    Serial.println("Failed to read from DHT sensor!"); 
  } 
  if (client.connect(server,80))  {   //--> "184.106.153.149" or api.thingspeak.com   
    String postStr = apiKey; 
    postStr +="&field1="; 
    postStr += String(t); 
    postStr +="&field2="; 
    postStr += String(h); 
    postStr +="&field3="; //BH1750 
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    postStr += String(lux); //BH1750 
    postStr +="&field4="; //Voltage sensor 
    postStr += String(volt); //Voltage sensor 
    postStr +="&field5="; //Voltage sensor 
    postStr += String(Current); //Voltage sensor 
    postStr +="&field6="; //Voltage sensor 
    postStr += String(Power); //Voltage sensor 
    postStr += "\r\n\r\n"; 
  
    client.print("POST /update HTTP/1.1\n"); 
    client.print("Host: api.thingspeak.com\n"); 
    client.print("Connection: close\n"); 
    client.print("X-THINGSPEAKAPIKEY: "+apiKey+"\n"); 
    client.print("Content-Type: application/x-www-form-urlencoded\n"); 
    client.print("Content-Length: "); 
    client.print(postStr.length()); 
    client.print("\n\n"); 
    client.print(postStr); 
    //LCD 
     
    lcd.setCursor(1, 0); 
    lcd.print("Solar Informations"); 
    lcd.setCursor(1, 1); 
    lcd.print("P=" + String(Power) + "W"); 
    lcd.setCursor(10, 1); 
    lcd.print("V=" + String(volt) + "V"); 
    lcd.setCursor(1, 2); 
    lcd.print("I=" + String(Current) + "A"); 
    lcd.setCursor(10, 2); 
    lcd.print("L=" + String(lux) + "lx"); 
    lcd.setCursor(1, 3); 
    lcd.print("T=" + String(t) + "C"); 
    lcd.setCursor(10, 3); 
    lcd.print("H=" + String(h) + "%"); 
 
 
  
    Serial.print("Temperature: "); 
    Serial.print(t); 
    Serial.print(" degrees Celcius, Humidity: "); 
    Serial.print(h); 
    Serial.println(" %"); 
    Serial.print("Light: "); //BH1750 
    Serial.print(lux); //BH1750 
    Serial.println(" lx"); //BH1750 
    Serial.print("Voltage: "); 
    Serial.print(volt); 
    Serial.println(" V"); 
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    Serial.print("Current: "); 
    Serial.print(Current); 
    Serial.println(" A"); 
    Serial.print("Power: "); 
    Serial.print(Power); 
    Serial.println(" W"); 
    Serial.println("Send to Thingspeak."); 
  delay(1000); //BH1750 
  } 
  client.stop(); 
  Serial.println("Waiting..."); 
   
  // thingspeak needs minimum 15 sec delay between updates 
  
} 
double mapf(double val, double in_min, double in_max, double out_min, double out_max) { 
  return (val - in_min) * (out_max - out_min) / (in_max - in_min) + out_min ; 
} 
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